
Experiment AM-1: Skeletal Muscle, 
Weight and Work

Background
About 40% of the total body mass of a human is 

skeletal muscle. Skeletal muscle is intimately associated 
with the skeletal system and, combined, these muscles 
and bones are responsible for supporting and moving 
the body. While skeletal muscle fibers have sarcomeres 
and the same banded appearance, different muscles can 
function in different ways. For example, some are 
relatively weak and fatigue resistant, while others are 
strong but fatigue quickly. These features may be 
explained in terms of the biochemical properties of 
muscles. 

The muscle fibers found in most mammalian skeletal 
muscles are either fast or slow twitch-types. Each type 
has a different myosin isoform, with different rates of 
ATPase activity and cross-bridge binding. Within the 
group of fast-twitch fibers, there are fibers that use 
glycolysis and oxidative phosphorylation. There are also 
fast-twitch fibers that just use glycolysis; this group is 
less reliant upon oxygen and is much stronger than the 
fibers using phosphorylation. However, these stronger 
“glycolytic” fibers breakdown glucose very inefficiently; 
so, that a burst of contractile activity diminishes glucose 
levels, causes lactic acid to accumulate, and leads to 
fatigue.

When a muscle tries to lift any weight, the muscle first 
shortens to put tension on the tendons which hold the 
muscle to the bones. Development of this tension before 
movement occurs takes time, known as the latency 
period, which is directly proportional to the weight 
attached to the muscle. Once the tension exceeds the 
weight of the object, any further muscle contraction 
produces a shortening of the muscle and a movement of 
the weight. The time that a muscle is in its active state 
(contracting) is finite; so, muscles have less time to 
shorten when they move heavier weights.

In this experiment, you will use a displacement trans-
ducer to determine how weight affects the shortening of 
a muscle. Weight influences the time that a muscle has 
to shorten, the speed at which the muscle shortens, the 
distance that the muscle shortens or moves the weight, 
and the amount of work the muscle completes. You will 
also compare the difference between: afterloading, 
supporting the weight before contraction; and 
preloading, hanging the weight on the muscle without 
support before contraction. 

Equipment Required
PC Computer

IWX/214 data acquisition unit

USB cable

IWX/214 power supply

DT-475 Displacement transducer 

A-BST-100 Stimulating electrodes

Double male banana-female BNC adapter

Ring stand and clamps 

Femur clamp

Thread

6” Ruler

Set of weights and pan

Amphibian Ringer’s solution (See appendix)

IWX/214 Setup
1 Place the IWX/214 on the bench, close to the computer.

2 Check Figure T-1-1 in the Tutorial chapter for the location of 
the USB port and the power socket on the IWX/214.

3 Check Figure T-1-2 in the Tutorial chapter for a picture of 
the IWX/214 power supply.

4 Use the USB cable to connect the computer to the USB port 
on the rear panel of the IWX/214. 

5 Plug the power supply for the IWX/214 into the electrical 
outlet. Insert the plug on the end of the power supply cable 
into the socket on the rear of the IWX/214. Use the power 
switch to turn on the unit. Confirm that the power light is on.

Start the Software
1 Click on the LabScribe shortcut on the computer’s desktop 

to open the program. If a shortcut is not available, click on 
the Windows Start menu, move the cursor to All Programs 
and then to the listing for iWorx. Select LabScribe from the 
iWorx submenu. The LabScribe Main window will appear 
as the program opens.

2 On the Main window, pull down the Settings menu and 
select Load Group.

3 Locate the folder that contains the settings group, 
IPLMv4.iwxgrp. Select this group and click Open.

4 Pull down the Settings menu again. Select the Skeletal 
Muscle-Weight-Work-LS2 settings file.

5 After a short time, LabScribe will appear on the computer 
screen as configured by the Skeletal Muscle-Weight-
Work-LS2 settings.

6 For your information, the settings used to configure the 
recording channels in the LabScribe software and IWX/214 
for this experiment are listed in Table AM-1-1 on page AM-
1-2.
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7 The settings used to configure the stimulator for this exper-
iment are listed in Table AM-1-2 on page AM-1-2. Both 
groups of settings are programmed on the Channel and 
Stimulator windows of the Preferences Dialog, which can 
be viewed by selecting Preferences from the Edit menu on 
the LabScribe Main window.

DT-475 and Stimulus Electrode Setup
1 Locate the following items in the iWorx kit: DT-475 

displacement transducer (Figure AM-1-1 on page AM-1-2); 
A-BST-100 bipolar stimulator cable (Figure AM-1-2 on page 
AM-1-2); Male double banana-female BNC adapter (Figure 
AM-1-3 on page AM-1-2).

 Figure AM-1-1: The DT-475 displacement transducer.

 Figure AM-1-2: The A-BST-100 bipolar stimulating electrode.

 Figure AM-1-3: The male double banana-female BNC 
adapter.

2 Plug the DIN8 connector of the DT-475 into the Channel 3 
input (Figure AM-1-4 on page AM-1-3).

3 Plug the male double banana-female BNC adapter into the 
positive (red) and negative (black) banana jacks of the IWX/
214 stimulator (Figure AM-1-4 on page AM-1-3). The 
banana plug that goes into the negative (black) stimulator 
output is identified by a tab, embossed with the letters GND 
(ground), on that side of the adapter (Figure AM-1-3 on 
page AM-1-2).

4 Attach the BNC connector of the A-BST-100 bipolar stimu-
lator cable to the adapter on the stimulator outputs (Figure 
AM-1-4 on page AM-1-3). 

Table AM-1-1: Settings on the Channel Window 
of the Preferences Dialog that Configure the 
iWorx System for Experiment AM-2.

Parameter Uni ts/Ti t le Sett ing Mode/
Function

Acquis i t ion Mode Chart

Start User

Stop User

Display Time Sec 10

Speed Samples/Sec 200

Channel  A3 Muscle Twitch S Record

Channel  S1 St imulus S Record

Table AM-1-2: Settings on the Stimulator 
Window of the Preferences Dialog that Configure 
the iWorx System for Experiment AM-2.

Parameter Units/Ti t le Sett ing

St imulus Mode Pulse

St imulator Start With Recording

Time Resolut ion msec 0.01

Toolbar Step Frequency Hz 0.5

Toolbar Step Ampl i tude Volts 0.01

Toolbar Step Time Sec 0.0001

Delay Sec 0.050

Ampl i tude (Amp) Vol t 4.00

Pulses (#pulses) Number 1

Pulse Width (W) msec 10

Frequency (F) Hz 0.5

Time Off  Ampl i tude Volts 0

Holding Potent ia l  (HP) Vol ts 0
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 Figure AM-1-4: The DT-475 displacement transducer and the A-BST-100 
bipolar stimulating electrode connected to the IWX/214.

The Dissection
1 Place a frog in ice water for 15 minutes. Double pith the frog 

as soon as it is removed from the ice water.

2 Remove the skin from the legs by making an incision 
through the skin around the entire lower abdomen. Cut the 
connections between the skin and the body—especially 
around the base of the pelvic girdle. Use stout forceps to 
pull the skin off the frog in one piece (like a pair of pants). 

3 Place the frog in a dissection tray with its dorsal side up. 

Note: Moisten the exposed limbs of the frog with Ringer's 
solution every five minutes or so.

4 Identify the Gastrocnemius muscle on the lower leg.

5 Use a glass hook to separate the Gastrocnemius muscle 
from the bone and other muscles of the lower leg. 

6 Use scissors to free the Achilles tendon from the connective 
tissue around the heel of the foot. Double up a 24” piece of 
thread. Firmly tie the doubled thread around the Achilles 
tendon, leaving the ends of the thread long enough to attach 
the muscle to the displacement transducer.

Note: Isolate as much tendon as possible, since it will be used 
to attach the muscle to the transducer. 

7 Cut the Achilles tendon as close to the bottom of the foot as 
possible, so the thread is still attached to the Gastroc-
nemius muscle. 

8 Move the Gastrocnemius muscle away from the rest of the 
lower leg. Cut the tibia just below the knee to separate the 
rest of the lower leg from the preparation. Rinse the prepa-
ration with Ringer’s solution to moisten the tissue and rinse 
away any blood.

9 Dissect away the muscles of the upper leg and expose the 
femur. Use a stout pair of scissors to cut the femur close to 
the pelvis. Rinse the preparation with Ringer’s solution to 
moisten the tissue and rinse away any blood.

The Preparation 
1 Use the femur clamp to mount the preparation on the 

ringstand (Figure AM-1-5 on page AM-1-3).

 Figure AM-1-5: The arrangement of the equipment used to evoke and 
record contractions from the frog Gastrocnemius muscle.

2 Attach the thread on the Achilles tendon to the upper eyelet 
on the rod of the displacement transducer. 

3 Use a paper clip to attach the weight pan to the lower eyelet 
on the rod. 

4 Adjust the femur clamp and the displacement transducer so 
the thread from the Achilles tendon to the transducer rod is 
vertical.

5 To prevent the weight in the pan from stretching the muscle, 
the knob on the upper end of the rod should be resting on 
the bushing in the top of the transducer case. 

6 Position the stimulating electrodes so they lay against the 
muscle about midway between the knee and the tendon. 
The two electrodes should not touch one another. 

7 Place two nickels (10 g) in the weight pan.
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Warning: The muscle preparation used in this experiment 
is functional for a limited period of time. If the muscle is 
bathed periodically in Ringer’s solution, it will work for 
about four hours. To conserve time, complete all the 
exercises in the experiment before analyzing the data. 

Exercise 1: Maximum Contraction 
Aim: To make sure all fibers contract when the muscle 

is stimulated.

Procedure
1 Click the Stimulator Preferences icon on the LabScribe 

toolbar (Figure AM-1-6 on page AM-1-4) to open the 
stimulator control panel (Figure AM-1-7 on page AM-1-4) 
on the Main window.

 Figure AM-1-6: The LabScribe toolbar.

2 Check the values for the stimulus parameters that are listed 
in the stimulator control panel on the Main window: the 
pulse amplitude (Amp) should be set to 4.0 V; the number 
of pulses (#pulses) to 1; and, the pulse width (W) to 
10ms. To change a stimulus parameter, click on the arrow 
buttons to the right of the window that displays the value of 
the parameter to increase or decrease the value, or type the 
value of the parameter in the window next to the label of the 
parameter. Click the Apply button to finalize the change in 
any stimulus parameter.

 Figure AM-1-7: The stimulator control panel

3 Click Record to stimulate the nerve with 4.0V. Type 4.0V in 
the Mark box to the right of the Mark button. and press the 
Enter key to attach a comment to the recording.

4 Click Stop to halt the recording.

5 Change the stimulus amplitude (Amp) to 4.5V using one of 
the techniques described in Step 2. Click the Apply button 
to finalize the change in the stimulus amplitude.

6 Click Record to stimulate the nerve with 4.5V. Type 4.5V in 
the Mark box and press the Enter key to attach a comment 
to the recording. 

7 Click Stop to halt the recording.

8 Repeat Steps 4, 5, and 6 using a stimulus amplitude (Amp) 
of 5.0V.

9 Select Save As in the File menu, type a name for the file. 
Choose a destination on the computer in which to save the 
file, like your lab group folder). Designate the file type as 
*.iwxdata. Click on the Save button to save the data file.

10 Moisten the muscle with frog Ringer's solution.

Exercise 2: Afterloaded Weight and Contractile 
Strength

Aim: To measure the strength of contraction while the 
muscle is lifting afterloaded weights.

Procedure
1 Make sure the thread connecting the Achilles tendon to the 

eye of the rod is vertical, and the knob on the upper end of 
the sliding rod of the transducer is resting on the top of the 
transducer case.

2 Check the values for the stimulus parameters that are listed 
in the stimulator control panel on the Main window. All 
stimulus parameters, except the pulse amplitude (Amp), 
should be set to the same values as the ones used in 
Exercise 1. Set the pulse amplitude (Amp) to a voltage 
that causes a maximal muscle response. To change a 
stimulus parameter, click on the arrow buttons to the right 
of the window that displays the value of the parameter to 
increase or decrease the value, or type the value of the 
parameter in the window next to the label of the parameter. 
Click the Apply button to finalize the change in any 
stimulus parameter.

3 Type 10g in the Mark box to the right of the Mark 
button.With the two nickels in the weight pan, click the 
Record button to record a single twitch. Press the Enter 
key on the keyboard to mark the trace. Click Stop to halt 
the recording. 

4 Add another 10g, or two more nickels, to bring the weight in 
the pan to a total of 20g. Type 20g in the Mark box. Click 
the Record button to record a single twitch. Press the 
Enter key on the keyboard to mark the trace. Click Stop to 
halt the recording. 

5 Increase the weight in the pan in 10g increments. Record 
the muscle response for each weight. Mark each recording 
to indicate the total weight lifted by the muscle. Continue to 
increase the weight until the muscle response is very small.

6 Select Save in the File menu.

7 Moisten the muscle with frog Ringer's solution.

Exercise 3: Preloaded Weight and Contractile 
Strength

Aim: To measure the strength of contraction while the 
muscle is lifting preloaded weights.

Procedure
1 Lower the displacement transducer. The knob on the lower 

end of the sliding rod should just be touching the bushing on 
the bottom of the transducer case. In this configuration, the 
weight in the pan stretches the muscle before it is stimu-
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lated. Make sure the thread connecting the Achilles tendon 
to the eye of the rod is vertical.

2 Repeat Exercise 2, applying the weights to the pan in 10g 
increments. Stop adding weight and recording responses 
when the muscle response is zero, or when the upper knob 
on the transducer rod contacts the bushing on the top of the 
transducer case.

3 Select Save in the File menu.

Data Analysis

Exercise 1: Maximum Contraction
1 Scroll through the data from Exercise 1 and find the first 

muscle twitch to be generated by a stimulus pulse. Click the 
AutoScale button to maximize the size of the muscle 
twitch on the window. Note the stimulus voltage used to 
generate this twitch.

2 Use the Display Time icons to adjust the Display Time of 
the Main window to show the stimulus pulse used to 
generate the twitch and the complete twitch on the Main 
window. The stimulus pulse and the twitch can be selected 
by:

• Placing a cursor before the stimulus pulse, and a cursor after 
the muscle has completely relaxed; and

• Clicking the Zoom between Cursors button on the 
LabScribe toolbar to expand the display of the stimulus pulse 
and the twitch to the width of the Main window.

3 Click on the Analysis window icon in the toolbar (Figure 
AM-1-6 on page AM-1-4) or select Analysis from the 
Windows menu to transfer the data displayed in the Main 
window to the Analysis window.

4 Look at the Function Table that is above the uppermost 
channel displayed in the Analysis window. The mathe-
matical functions, V2-V1 and T2-T1 should appear in this 
table. Values for V2-V1 and T2-T1 on each channel are 
seen in the table across the top margin of each channel.

5 Maximize the height of the trace on the Muscle Twitch 
Channel by clicking on the arrow to the left of the channel’s 
title to open the channel menu. Select Scale from the 
menu and AutoScale from the Scale submenu to increase 
the height of the data on that channel.

6 Once the cursors are placed in the correct positions for 
determining the amplitudes and times for each muscle 
twitch, the values of the parameters in the Function Table 
can be recorded in the on-line notebook of LabScribe by 
typing their names and values directly into the Journal, or 
on a separate data table.

7 The functions in the channel pull-down menus of the 
Analysis window can also be used to enter the names and 
values of the parameters from the recording to the Journal. 
To use these functions:

• Place the cursors at the locations used to measure the 
amplitude and times of each muscle twitch.

• Transfer the names of the mathematical functions used to 

determine the amplitude and times to the Journal using the 
Add Title to Journal function in the Muscle Twitch Channel 
pull-down menu.

• Transfer the values for the amplitude and times to the 
Journal using the Add Ch. Data to Journal function in the 
Muscle Twitch Channel pull-down menu.

8 On the Muscle Twitch Channel, use the mouse to click on 
and drag the cursors to specific points on the recording to 
measure the following parameters: 

• Muscle Twitch Amplitude, which is the difference between 
the baseline tension of the muscle and the tension at the peak 
of the twitch. To measure this parameter, place one cursor at 
the beginning of the twitch, and the second cursor on the peak 
of the twitch. The value for the V2-V1 function on the Muscle 
Twitch Channel is the muscle twitch amplitude.

• Contraction Time, which is the time between the beginning 
and the peak of the twitch. To measure this parameter, keep 
the cursors in the same positions used to measure the muscle 
twitch amplitude. The value for the T2-T1 function on the 
Muscle Twitch Channel is the contraction time of the twitch.

• Relaxation Time, which is the time between the peak of the 
twitch and the return of the muscle tension to the baseline 
level. To measure this parameter, keep the cursor on the peak 
of the twitch and place the other cursor at the end of the twitch. 
The value for the T2-T1 function on the Muscle Twitch 
Channel is the relaxation time of the twitch.

• Latency, which is the time it takes the muscle to start 
responding to a stimulus. Place one cursor at the beginning of 
the stimulus pulse, and the other cursor at the beginning of the 
muscle twitch. The value for the T2-T1 function on the Muscle 
Twitch Channel is the latency of the muscle response

9 Record the values in the Journal using the one of the 
techniques described in Steps 7 or 8, and on Table AM-1-3 
on page AM-1-6.

10 Repeat Steps 2 through 9 to find the muscle twitch 
amplitude, contraction time, relaxation time, and latency of 
the other muscle twitches recorded in this exercise. Record 
the values in the Journal and on Table AM-1-3 on page 
AM-1-6.

11 Select Save in the File menu.

 Figure AM-1-8: A single muscle twitch and stimulus pulse displayed in the 
Main window. The labels indicate: latency (L); contraction time (C); relax-
ation tine (R); and twitch amplitude (A).
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Exercise 2: Afterloaded Weight and Contractile 
Strength.
1 Scroll through the data from Exercise 2 and find the muscle 

twitch generated while the muscle lifted the lightest weight.

2 Use the same techniques to measure the data from this 
exercise as used to measure the data from Exercise 1.

3 Record the values for the amplitudes and times from the 
twitches in this exercise in the Journal and on Table AM-1-
4 on page AM-1-6 using the same techniques used in the 
analysis of the data from Exercise 1. 

4 Calculate the work performed and the rate of contraction for 
each twitch: 

• Work equals weight multiplied by the amplitude of muscle 
response. 

• Rate of contraction equals this amplitude divided by 
contraction time (C).

5 Repeat the measurements for all twitches. 

6 Present your data in tables and graphs that relate the 
amplitude of the muscle response, the work performed, and 
the speed of contraction to weight.

Questions
1 Why did the amount of work initially increase with increased 

weight? 

2 Why did the amount of work decrease when heavier 
weights were used? 

3 Did any of the other parameters measured differ with 
weight? Why?

Exercise 3: Preloaded Weight and Contractile 
Strength. 
1 Scroll through the data from Exercise 3 and find the muscle 

twitch generated while the muscle was holding the lightest 
weight.

2 Use the same techniques to measure the data from this 
exercise as used to measure the data from Exercise 1.

3 Record the values for the amplitudes and times from the 
twitches in this exercise in the Journal and on Table AM-1-
5 on page AM-1-6 using the same techniques used in the 
analysis of the data from Exercise 1.

Question
How do the muscle response parameters of a 

preloaded muscle compare to those of an afterloaded 
muscle?

Table AM-1-3: Amplitudes and Times of Maximal 
Muscle Contractions.

Stimulus 
Ampl i tude (V)

Muscle Twitch

Ampl i tude
(mV)

Contract  
Time

(msec)

Relax 
Time

(msec)

Latency
(msec)

4.00

4.50

5.00

Table AM-1-4: Amplitudes and Times of 
Contractions from an Afterloaded Muscle.

Weight (g)

Muscle Twitch

Ampl i tude
(mV)

Contract  
Time

(msec)

Relax 
Time

(msec)

Latency
(msec)

10

20

30

40

50

60

70

Table AM-1-5: Amplitudes and Times of 
Contractions from a Preloaded Muscle.

Weight (g)

Muscle Twitch

Ampl i tude
(mV)

Contract  
Time

(msec)

Relax 
Time

(msec)

Latency
(msec)

10

20

30

40

50

60

70
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Appendix

Table AM-1-6: Amphibian Ringer ’s Solution

Concentrat ion
(mMolar) Salt

Grams/Li ter
DI H20

111.0 Sodium Chlor ide 6.49

1.9 Potassium Chlor ide 0.142

1.06 Calcium Chlor ide∗2H2O 0.156

1.0 Tr is 0.121

5.55 Glucose 1.00

Adjust  pH to 7.6 with 6N HCl
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